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Chapter 1: About the DPC System Data Acquisition
Software

Program Description
The DPC (Digital Photon Counting) System Data Acquisition Software is an easy-to-use
32-bit software application.  This version of the software applies to the DPC data
acquisition software that uses the Model PC-DAQ controller card.  The DPC Data
Acquisition offers powerful data collection features using a standard Windows  interface.
The software allows the user to:

! Acquire photon counting data from any TTL source.  Counting rates are software-
selectable and can be set from 2 to 10,000 data points per second.

! Make analog measurements in synchrony with photon counting data (DPC-2 only). Up
to eight channels of analog data (0 to 5 Volt) can be collected.

! View photon counting data and analog channels on the computer monitor, in real time,
as it is acquired.

This manual is applicable for both the DPC-1 and DPC-2.  The main difference between
these two software packages is that the DPC-2 includes the capabilities for analog data
acquisition.  Throughout this manual, it will be noted which software features only apply
to the DPC-2.

System Requirements
The computer used for the DPC-1 and DPC-2 data acquisition and analysis software
requires the following minimum configuration:

! Pentium  133 MHz computer

! At least one free 16-bit ISA slot in the computer

! Windows  95 or Windows  98 operating system

! 16 MB of RAM (32 MB recommended)

! Mouse input device

Screen resolution of 600 x 800 pixels (or greater) with 256 colors (or greater) is
recommended.

Technical Support
If you run into problems while using the DPC Data Acquisition software, first check
Chapter 10: Troubleshooting for solutions to common problems.  For additional support,
and to report software bugs or documentation errors, contact C&L Instruments. Contact
information is listed on the front cover of this manual.
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About this Manual

What’s Covered
This manual covers the installation and operation of C&L’s DPC Data Acquisition
software. It is assumed that the user is already familiar with the following:

! Photon counting and/or fluorescence spectroscopy concepts and procedures

! How to use Windows  95 or Windows  98

Obtaining Current Documentation
The most current version of this User Manual is available for downloading at the C&L
Instruments, Inc. Web site. See the front cover of this manual for the URL.
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Chapter 2: Software and Hardware Installation

Overview
This chapter explains how to install the PC card into the host computer and install the
Data Acquisition software.

Installing the Hardware

Installing the PC-DAQ Controller Card
If you did not purchase a computer from C&L Instruments along with the DPC-1 or DPC-
2 system, you will need to install the PC-DAQ Controller card and software in your
computer.

The PC-DAQ Controller card is a 16-bit ISA card.  It can operate in two modes: Plug and
Play (PnP) and non-Plug and Play (non-PnP).  Non-PnP is sometimes called legacy mode.
In PnP mode, the installation process is automatic, in that the Windows operating system
will assign the necessary hardware interrupt (IRQ) and base address (I/O address) to the
PC-DAQ Controller card without user intervention.  In non-Plug and Play mode, the user
must set jumpers and switches on the Controller card to manually set the hardware
interrupt and base address.  The non-PnP mode is generally reserved for special cases
when a resource conflict in the computer must be resolved by manual intervention by the
user.

It is recommended that the user install the PC-DAQ Controller card in PnP mode.  In this
mode, the installation is considerably easier, and the operating system automatically
assigns resources to the card.  The following instructions outline the procedure to install
the PC-DAQ Controller card in the PnP mode.  Contact C&L Instruments for instructions
for installing the card in non-PnP mode.

Note that a similar PC card (PC-DAQ Controller) manufactured by C&L Instruments is
used by the C&L Instruments Dye Fluorometer.  If you wish to upgrade your DPC system
to the multiwavelength capabilities of the photon counting system available in the Dye
Fluorometer, please contact C&L Instruments to determine if your version of the PC card
supplied with your DPC system is capable of operating the Dye Fluorometer

To install the PC-DAQ Controller card in PnP mode, follow these steps:

1. Turn off all electrical power to the computer.

2. Open the computer case.  Refer to the manual that came with your computer if you do
not know how to open the computer case.

3. Install the PC-DAQ controller card in an empty ISA slot. Note that the Controller card
has one single jumper in the lower left side of the card (Jumper J11).  This jumper
must be off (i.e., open position) to select PnP mode.  Secure the card in the chassis
using the hardware provided by the computer manufacturer.  Usually one screw is
used to hold an ISA card in place.

4. Close the computer case.
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5. Start the computer.

When the computer restarts for the first time after installing the PC-DAQ Controller card,
Windows should find the new hardware and report:

“New Hardware Found  -  ISA PnP S48C Data Acquisition”

Follow the instructions by Windows.  When prompted for location of the driver, insert the
floppy disk comes with the PC-DAQ Controller card and direct Windows to install the
driver from the floppy disk.

To make sure the card is installed correctly, open the Control Panel (in the Start menu,
under Settings / Control Panel).  Select System, and then the Hardware Manager tab.
There should be an entry indicating “Virtual Motor Driver” under the “C&L Instruments”.
Select the device with the left mouse button and check the Properties of the device.
Windows should have assigned resources to the PnP Controller card.  Windows may
report something similar to the following:

Interrupt Request  05

Input/Output Range  0280-02BF

The Interrupt Request and Input/Output Range assigned to the PC-DAQ Controller in
your computer may differ from the above example.

Note: The current device driver supplied with your PC-DAQ Controller card has been
fully tested with Windows 95 version 4.00.950, Windows 95 version 4.00.950 B (OSR2),
Windows 98, and Windows 98 Second Edition.  If you upgrade or install a new operating
system, it is recommended that you open the computer case and remove the card from the
computer before you start the upgrade or installation.  After the upgrade or installation is
complete, reinstall the PC-DAQ card.

Installing the DPC-1 and DPC-2 Data Acquisition Software
After installing the PC-DAQ Controller card in your computer, you need to install the
Data Acquisition Software.  To install the Data Acquisition software, follow these steps:

1. Insert the diskette provided by C&L Instruments.

2. Using the Run… command in the Windows Start menu, launch the Setup.exe
program provided on the diskette.

3. Follow the installation directions on the screen.  Read the License Agreement that is
displayed by Setup.

When the software installation is complete, several system files will be stored in the
Windows/System directory.  The main software files and the default configuration file
will be placed in subdirectory structure under either the C:\Program Files\CandL\DPC
directory created by Setup or the directory you specified during the installation process.
Reboot the computer before using Data Acquisition for the first time.
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Chapter 3: Fundamentals of Data Acquisition

Overview
This chapter describes some of the basic ways in which the DPC hardware and software
work together to monitor and save data obtained from your samples. Understanding the
fundamentals of hardware and software functioning will enable you to control the data
acquisition process effectively.

The use of specific software functions is covered in greater detail in Chapter 7: Acquiring
Data and Chapter 8: Viewing Data.

Data Acquisition Mode
Data is acquired by specifying the acquisition aperture time and by turning data
monitoring on.  All data is recorded as a function of elapsed time.  If analog data is
acquired together with photon counts, these data are acquired at the same rate and in
synchrony.  Further details of data acquisition are a topic of Chapter 7: Acquiring Data.

Shutters (DPC-2 Only)
The DPC-2 system is equipped with a Breakout box.  This accessory connects to the PC-
DAQ card in the PC with a SCSI cable.  The Breakout box contains the analog input BNC
connectors.  It also has TTL output connectors for the control of external shutters (shutters
are not provided).  The shutter outputs can be controlled through the Data Acquisition
software to limit either the sample’s or the photomultiplier tube’s exposure to excessive
light.  Moreover, the shutters can be controlled through software either manually or
automatically.  Through the software, the user can control shutters to limit either the
exposure of the sample or the collection of light by the photomultiplier.

Fluorescence and Photon Counting
Together with a TTL-output photomultiplier, the DPC-1 and DPC-2 can be used as a very
sensitive photometer.   A typical applications is for fluorescence measurements, in which
the intensity of light emitted from a fluorescent sample is measured when excited by
excitation energy.  C&L Instrument can provide photomultipliers for these applications.
Photon-counting PMT’s capture single photons and converts the photon energy into
pulses of electric current.  These pulses, which are proportional to the intensity of light
impinging on the PMT, are counted by the DPC data acquisition system.  The photon-
counting method of light detection is unparalleled for high sensitivity and accurate
detection of low light levels.  The DPC System counts these pulses in discrete time
intervals.  The count rate is proportional to the intensity of the light impinging on the
photomultiplier.

The Data Acquisition software can display these data as either  “counts” or “counts per
second”, depending on the preference of the user, in a separate program window
designated as the PMT Counts window.  One or more PMT Counts widow(s) can be
opened to view the data and each window can be separately customized with different
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display options.  These acquired “counts” represent the number of photon counts
accumulated within the specified acquisition period.  Throughout this manual, the
acquisition period is referred to as the sampling time.  The sampling time is determined
by a value keyed into the Setup Options dialog box.

Data acquisition sequences can be acquired continuously or as single data points,
depending on the mode of data acquisition.  The DPC Data Acquisition software contains
a Single Sample Mode that is designed for short data acquisition sequences.  These
sequences can be acquired one at a time, or in an automated fashion using a programmed
time interval.

The Single Sample Mode allows the user to acquire a brief data sequence.  Acquisition
will then wait for either a key entry from the user or a specified time period before
acquiring a second data set.  This is repeated until the user decides to write the data to a
file.  This feature saves the user from having to collect multiple files for short-duration
data acquisition sequences.

Measuring Fluorescence by Balancing Factors
Since the DPC System is often used for the measurement of fluorescence emission, this
section can be used as a guide to facilitate these types of measurements.  Several factors
influence the intensity of the acquired fluorescence signal by the DPC System.
Obviously, the concentration of the fluorescent dye and its quantum yield affect the
observed intensity.  But there are additional factors that can be controlled that affect the
number of fluorescence counts detected within the sampling time.  Two primary factors
are the excitation lamp intensity and setting of the sampling time.

Excitation Lamp Intensity
The PMT used in photon-counting applications will respond to light intensity in a linear
fashion up to a maximum count rate that is specified by the manufacturer of the PMT.
The user should adjust the excitation intensity in order to maintain the PMT in the linear
range.  Adjusting either the characteristics of the sample or the excitation energy or
emission collection efficiency can be used to alter the count rate.

Sampling Time Setting
The number of counts collected within the sampling period is dependent on the count rate
and the sampling time.  A long sampling time can be used to collect light from a weakly
fluorescing sample.  A long sampling time, however, may cause saturation of the counter
in the DPC system, especially if the sample is strongly fluorescent.  In the latter case, the
user can either adjust the count rate, as described above, or use a shorter sampling time.
The DPC system uses a 16 bit counter and can count up to 216 (i.e., 65,536) counts within
a sampling period before saturation of the counter occurs.  A feature in the software will
indicate to the user if this saturation occurs.  See Data Overflow in Chapter 8: Viewing
Data for a discussion of this topic.  The setting of the sampling time is discussed in more
detail in Chapter 7: Acquiring Data.
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The DPC system can display the observed light intensity in units of Counts or
Counts/second.  In the Counts mode, the number of counts accumulated within the
sampling time is displayed.  In the Counts/second mode, the count rate is displayed as the
accumulated counts divided by the sampling time in seconds.  Further details about
viewing fluorescence data are discussed in Chapter 8: Viewing Data.

Acquisition of Analog Data (DPC-2 Only)
Along with the acquisition of PMT Counts data, the DPC-2 system is able to monitor and
record external events through acquisition of analog data.  Inputs are provided for
acquisition of up to eight analog channels.  Data can be acquired within an input range
between 0 and 5 Volts.  The DPC-2 is equipped with a 12 bit analog-to-digital converter,
providing a resolution of 1.2 mVolt within the 0 to 5 Volt range.  This feature gives the
user the ability to record events that may be occurring simultaneously with the recording
of photon counts.
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Chapter 4: Getting Started

Overview
 This chapter will quickly familiarize the user with the basic operating steps required for
collecting data with the DPC system.

Further details about acquiring and viewing data are provided in the following three
chapters, which describe all available software features and explain how they are used to
acquire and view data.  The user is encouraged to read these chapters so that all the
features of the instrument can be utilized to their fullest potential.

The Data Acquisition Process
The user starts the data acquisition process by setting up the software parameters to collect data
under specified conditions.  The user then starts and stops a data acquisition session.  After data
has been acquired, it is written to a file for later analysis.  The fluorescence and analog
signals can be monitored between periods of data acquisition.

Basic Steps in Data Acquisition
To begin and end a data acquisition session, there are only five basic steps to follow.

1. Turn on all external hardware.

2. Launch the DPC Data Acquisition software.

3. Specify and/or load previously specified Setup Options for data acquisition.

4. Enable the Run feature to begin monitoring PMT Counts.

5. Start and Stop a recording session.
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Chapter 5: Command Reference

Overview
This chapter describes in detail all features of the Data Acquisition software that are
available to the user.  The user has control over how the DPC system acquires data by
specifying various Setup Options in the Data Acquisition software.

The following features are covered, in the listed order:

! Main program window and child windows

! Drop-down menu bar and individual drop-down menu items, including the Setup
Options dialog box

! Toolbar

! Status bar

Before reading this chapter, it is recommended that the user become familiar with the
concepts introduced in the preceding chapters.  The upcoming two chapters, Chapter 7:
Acquiring Data and Chapter 8: Viewing Data, explain how the software functions
discussed in the present chapter can be used to acquire data in a specific fashion.

Main Program Window and Child Windows
The Data Acquisition program opens as one main program window containing a typical
Windows title bar and a drop-down menu bar. The title bar displays the name of the
configuration file that is currently loaded into memory. The configuration file is discussed
in greater detail later in this chapter and in Chapter 7: Acquiring Data.

Figure 1.  The main program window.
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When the Data Acquisition program is first started, the main program window contains
either two or three “child” windows, as shown in Figure 1.  If the child windows are not
observed, it is because a configuration file has not been loaded.  Open a configuration file
using the File / Open command.  Data Acquisition will automatically open the last
configuration file used.  If no configuration files are shown in the Open Configuration File
dialog box, type a name and select Open.  The acquisition program will open a new dialog
box asking you if you want to create this file.

Figure 2.  The Open Configuration File dialog box.

The child windows—Timer, PMT Counts and Analog—are used to view the data as
monitored by the Digital Photon Counting system.  For further details about the use of
these windows to display data, see Chapter 8: Viewing Data.

Drop-down Menu Bar
Under the program title bar is the drop-down menu bar, which contains the following
menus: File, Options, Shutter, Record, Display, View, Window and Help.  Through
these drop-down menus, all features of the Digital Photon Counting system can be
controlled.  In addition, some menu options are also available using the icons that are
available in the Toolbar.  The use of these icons as shortcuts to specific menu options is
discussed in Chapter 6: Using the Icons in the Toolbar.

The drop-down menus serve the following functions.  Each menu is described in greater
detail in the following sections.

! File - Allows the user to Open and Save configuration files, specify Setup Options,
control the fluorometer hardware components, print the contents of data windows, and
exit the program.

! Options - Allows the user to specify the Color of various channels and text and check
the interface settings for the DPC controller PC Board.

! Shutter - Allows the user to open and close the excitation and emission shutters
manually.

! Record - Allows the user to Start and Stop the data acquisition process or used the
Timed feature for fixed duration data acquisition.

! Display - Allows the user to specify the data channels to be displayed in the Analog
windows (DPC-2 only).
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! View - Allows the user to toggle the main program window’s Toolbar and Status Bar
on and off.  Also allows the user to perform various actions to manipulate the
presentation of data in the active PMT Counts or Analog (DPC-2 only) windows.
These actions include Zoom In, Zoom Out, Unzoom or Move Up or Move Down the
scale of the Y-axis, and change the Settings… of the zoom function.

! Window - Allows the user to open New PMT Counts, or New Analog data windows.
Also allows the user to select the active window and to arrange the child windows
within the main program widow using the Cascade, Tile and Arrange Icons options.

! Help - Allows the user to access on-line information About C&L Instruments.

File Menu
The File menu contains the following options:

! Open...,

! Save,

! Save As...,

! Setup Options...,

! Run,

! Print...,

! Print Preview,

! Print Setup...,

! 1 [filename] (etc.)

! Exit

These options are described in detail below.

File / Open…
Opens a dialog box in which the user can locate and open a specific configuration file.
The configuration file is used to store and recall all C&L Dye Fluorometer settings.
Configuration files are stored with the .cfg extension.  This feature is generally used to
save all system setting for a particular experiment so that the settings can be easily
recalled at a later date.

File / Save
Saves the current settings in the currently loaded configuration file using the same file
name.

File / Save As…
Opens a dialog box in which the user can save the current settings as a new configuration
file using a new file name.
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File / Setup Options…
Opens the tabbed Setup Options dialog box that is used to set up most hardware and
software features.

The Setup Options dialog box is covered in detail later in this chapter.

File / Run
Activating Run causes DPC to begin monitoring photon counts in the PMT Counts
window and analog data in the Analog window (DPC-2 only).  After the Run command
has been enabled, data is displayed in the Analog window provided that data channels
have been enabled for viewing using the Display menu item.

File / Print...
Prints the contents of the active window.

File / Print Preview
Allows the user to preview the output of the Print command on the monitor screen prior to
printing.

File / Print Setup...
Allows the user to change the printer device and to specify other print options available
through the printer driver.

File / 1. [file name] (etc.)
Displays the list of the most recently used configuration files.  Selecting one of these file
names provides a shortcut for opening previously used C&L DPC configuration settings.

File / Exit
Terminates the Data Acquisition program.

Setup Options Dialog Box
Clicking on Setup Options... in the File menu opens the tabbed Setup Options dialog
box.

The tabs, from left to right, are Shutter Mode, Sampling Time, Record, and Analog.
Each tab is described in greater detail below.

Once you have specified the desired settings on the appropriate tabs, choose OK to accept
them or Cancel to return to the previous settings.



Chapter 5: Command Reference

DPC system Data Acquisition Software User Manual (version 1.0) Page 17

Shutter Mode

Figure 3.  The Shutter Mode tab in the Setup Options dialog box.

Specifying Shutter Control Modes
The Shutter Mode tab displays the choices for control of two shutters by the DPC
system.  The settings in the Shutter 1 and Shutter 2 sections are used to indicate the
shutter control mode for the excitation and emission shutters.  These shutters can each
be controlled in three ways: Auto Always, Auto Acquisition, and Manual, which are
described below.  Contact C&L Instruments for instructions on how to connect
shutters to the DPC system

! In the Auto Always mode, the shutter(s) will always remain in an automatic
control mode.  Manual control of the shutter using the Shutter menu is disabled in
this shutter mode.  Auto Always indicates that the shutter(s) are always linked to
the Start, Timed and Stop options (in the Record menu) used to control data
acquisition.  When either Start or Timed is selected to begin data acquisition, the
software checks the state of the shutter.  If the shutter is open, it remains open.  If
it is closed, the shutter is opened.  When either the Stop feature is selected or the
period of Timed data acquisition expires, the software closes the shutter.  This
mode allows shutters to be used to insure that the sample and/or the detector are
exposed to light only during data acquisition.

! In the Auto Acquisition mode, the shutter(s) are controlled by data acquisition, as
discussed above for the Auto Always mode, except that manual control is also
permitted.  That is, automatic control of the shutter occurs only after the Start,
Stop and Timed commands are used to control data acquisition. When either Start
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or Timed is selected to begin data acquisition, the software checks the state of the
shutter.  If the shutter is open, it remains open.  If it is closed, the shutter is opened.
When either the Stop feature is selected or the period of Timed data acquisition
expires, the software checks the state of the shutter.  If the shutter is open, the
software closes the shutter.  If it is closed, the shutter remains closed.  In between
periods of data acquisition, the shutters can be controlled manually.

! In the Manual mode, the shutter(s) are controlled only by the options in the
Shutter menu.  Selecting Start, Stop or Timed does not change the state of the
shutter(s) while in the manual mode.

Sampling Time Tab

Figure 4.  The Sampling Time tab in the Setup Options dialog box.

The setting of the sampling time determines the time interval over which photons are
collected.  The minimum valid entry is 0.1 milliseconds.  The DPC uses a 16-bit counter,
so the sampling time must be set so that less than 65,536 photons are counted in one
sampling period.  Further details about the setting of the sampling time can be found in
Chapter 7: Acquiring Data.
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Record Tab

Figure 5.  The Record Tab in the Setup Options dialog box.

The Record tab has three sections in which the user can specify details of how data files
are to be recorded: Record File, Experiment Title, File Index, and Recording Time.  There
is also a check box to enable the operation of the Single Sample Mode.

Specifying the Data File Name and Path
In the Record File section, the user specifies the Name and Path of the data file that
will be saved after completion of a data acquisition sequence.  The Browse button is
used to open a dialog box in which the user can specify the path to the directory used
to store the data file.  The data file is automatically given the extension of “.flu,” as
indicated in the Ext field.

Specifying an Experiment Title
In the Experiment Title field, the user can enter an optional name for the experiment
title.  This title will be recorded along with the data in the data file.

Specifying Auto Incrementing
The Auto Increment feature is used to automate the file naming process so that files
can be named in a simple numbered sequence without further intervention by the user.
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This feature is enabled with the Auto Increment File check box.  When enabled, the
indicated file name is appended with the number indicated in the File Index field.  If
desired, the user can use the up and down arrows to change the index number. The
name of each successive file is then incremented by 1 after each data acquisition
session.  For instance, if the index “1” is used for the first data file called “Test,” files
will be saved sequentially as “Test1.flu”, “Test2.flu”, “Test3.flu”, etc.

Specifying the Recording Time
The Recording Time section is used to specify the duration of time that data is
recorded when using the Timed recording feature.  In Timed recording, data is
recorded for the time interval indicated in the Recording Time field.  (See the Record
Menu section, later in this chapter, for more information on recording modes.)

Using the Single Sample Mode
The Single Sample Mode is used to collect data in either short bursts, or a series of
short bursts separated by a time interval.  When this feature is disabled, data is
acquired continuously at the  sampling rate specified in the Sampling Time dialog
box.  In this case, the data is collected as a continuous sequence that is stored as one
file.

In some instances, however, it may be desirable to collect shorter period of data
separated by one or more waiting periods, and have all the data saved as one file.  This
feature is most useful when using the C&L Instruments Model CV1 Cuvette
Accessory.  This is to allow the user to make additions to the cuvette or to change the
cuvette.  This feature, however, can be used in any data acquisition protocol.  With the
Single Sample Mode, data can be collected for each sample and the entire data set can
be saved as one file.

This sample mode can also be used to collect data intermittently from one sample in
order to avoid exposing the specimen to excessive illumination light.  In this instance,
data can be collected for brief periods that are separated by a longer time interval.

Data acquisition in the Single Sample Mode can be synchronized to the operation of
the excitation and/or emission shutter(s) to restrict illumination of the specimen and/or
the detector to light in between periods of data acquisition.  See Specifying Excitation
Shutter and Emission Shutter Control Mode, described above, for more detail.

For more information about recording, see Chapter 7: Acquiring Data.

Analog Tab
The Analog tab allows the user to enable or disable the recording of analog data on a
channel by channel basis.  Recording of analog data is only available in DPC-2 version of
the Digital Photon Counting system.

In the Enable and Record Analog Data section, channels are listed as Analog 1 through
Analog 8. Placing a check in a given check box enables recording of analog data on the
indicated channel.
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When an analog channel is enabled, the user can display the data in the Analog data
window.  If a specific analog data channel is disabled, it is not available for display. (For
more information about viewing data, see Chapter 8: Viewing Data.)

The All Select button enables (checks) all of the analog channels.

The All Release button disables (unchecks) all of the analog channels.

For more information about recording analog data, see Chapter 7: Acquiring Data.

Figure 6.  The Analog tab in the Setup Options dialog box.

Options Menu
The Options menu contains the following menu items:

! Color…

! Board…

These options are described in detail below.

Options / Color… and the Color Dialog Box
Opens the Color Dialog box.

The Color Dialog box is used to change the color of the data points and text displayed in
the PMT Counts and Analog data windows.  Up to eight channels of data can be displayed
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in the Analog data window (DPC-2 only).  Using different colors allows you to more
easily visualize the data in each channel.

Selecting Channel Color
Clicking on the button for the desired channel in the Channel Color section displays a
standard Windows  Color selection dialog box.  The same Channel colors are used in
both the Fluorescence and Analog data windows.  The color selected for #1 (i.e.,
Channel 1) is used for the display of the fluorescence ratio in the Fluorescence Ratio
window.

Figure 7.  The Color Dialog Box.

Selecting Text Color
Clicking on Text allows the user to change the color of the text that appears in the data
windows. The same text color is used in the Fluorescence, Analog and Fluorescence
Ratio windows.

Accepting and Canceling Changes
Clicking on the Default button will revert all color changes to their default setting.

Clicking on OK closes the Color Dialog Box and saves all changes.

Clicking on Cancel cancels all changes and causes the colors to remain the way they
were prior to opening the Color Dialog box.

If desired, the user can also change the background color of the data windows.  This is
accomplished by editing the Properties of the Windows  desktop.  Further instructions
can be found in the Windows 95 user manual.
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Options / Board
Selecting Board will open a dialog box that indicates the hardware interrupt and the base
address used by the PC card.  This dialog box is only used for diagnostic purposes should
the PC card not respond to user commands.  If this is observed to occur, refer to the Help
section at the end of this manual for a troubleshooting guide.

Shutter Menu
The Shutter menu options allow the user to control the shutters manually when the shutter
control mode has been set to either Auto Acquisition or Manual. When the shutter
control mode is set to Auto Always, the Shutter menu options are disabled. For details
about the shutter control mode, see the Mode Tab of the Setup Options dialog box, under
File / Setup Options.

The Shutter menu options are:

! Open Shutter 1 - Opens the shutter 1 (if closed) or closes it (if open).

! Open Shutter 2 - Opens the shutter 2 (if closed) or closes it (if open).

When a shutter is open, a check is placed next to the entry in this menu.

Record Menu
The Record menu options are used to start and stop the recording of data. The length of a
data recording session can be controlled manually or on a timed basis. The Record menu
options are:

! Start

! Stop

! Timed

These options are described in detail below.

Record / Start
Starts the recording of data to be saved to a file.  The Start option is only enabled after the
Run operation is initiated to begin monitoring of the data in the data windows (see File /
Run, above).

Using Start to initiate data recording will cause the Data Acquisition software to begin
recording data.  After selecting Start, data will continue to be recorded until either the
data buffer is full or the user selects the Stop command, whichever occurs first.  The data
buffer becomes full when any fluorescence channel has accumulated 10,000 data points.
The duration of time required to fill the data buffer is dependent on the speed of data
acquisition.  For instance, using a sampling period of 100 milliseconds allows the user to
collect a data file over a period of 1,000 seconds, or about 16.6 minutes.
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Record / Stop
The Stop command stops the recording of data and tells the user when the data in the
computer RAM has been written to a file.  Stop will stop the recording of data when
either the Start or Timed option was used to initiate recording.  The name of the data file
is specified in the Record tab of the Setup Options dialog box (see the Record Tab
section, above).  When Stop is selected, recording is stopped and a message box appears
to inform the user that the data file has been saved.

Record / Timed
This option starts the recording of data for a fixed period of time.  The time duration for
data collection with the Timed option is set in the Record tab of the Setup Options
dialog box.  The Timed option is only enabled after the Run operation is initiated (see
File / Run, above).

Display Menu
The Display menu allows the user to specify the data channels that will be displayed in
the Analog data window. The Display menu is available on the menu bar only when the
Analog window is active.

Analog Window Display Options
If an Analog window is active when Display is selected, then the following options are
available for selection in the Display drop-down menu. These channels can be enabled for
display in the same manner as described above for the Fluorescence channels.

! Analog 1
! Analog 2
! Analog 3
! Analog 4
! Analog 5
! Analog 6
! Analog 7
! Analog 8
! Select All
! Deselect All

Number of Channels Enabled
The number of analog channels that are enabled on this menu depends on the setting in
the Analog tab of the Setup Options dialog box.  Only the analog channels that have
been enabled in the Analog tab are available for selection in the Display menu.

Selecting and Deselecting Channels
Channels can be selected (indicated by a checkmark) or deselected individually by
clicking on the appropriate options.

Selecting Select All selects all enabled analog channels.
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Selecting Deselect All removes the selection from all enabled analog channels.

View Menu
The View menu allows the user to control certain aspects of the appearance of the main
program window and data windows.  In similar fashion to the Display menu, the View
menu options vary depending on the type of window that is currently active.

If either the main program window or the Timer window is active, the following menu
options are available in the View menu.

! Toolbar
! Status Bar

If an Analog window is active, the following menu options are available in the View
menu.

! Toolbar
! Status Bar
! Lines
! Zoom In
! Zoom Out
! Move Up
! Move Down
! Unzoom
! Settings…

If a PMT Counts window is active, the following menu options are available in the View
menu.

! Toolbar
! Status Bar
! Counts
! Counts/sec
! Zoom In
! Zoom Out
! Move Up
! Move Down
! Unzoom
! Settings

View / Toolbar
Displays or hides the Toolbar.

View / Status Bar
Displays or hides the Status Bar.
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View / Lines
Enables the display of lines between the data points in the Analog window.  The display
of lines is only available in the Analog data window.

View / Counts and View / Counts/Sec
Changes the units on the Y axis in the active PMT Counts data window.

! Selecting Counts changes the units to Counts.

! Selecting Counts/Sec changes the units to Counts/Second.

View / Zoom In, / Zoom Out, / Move Up, and / Move Down
The Zoom In, Zoom Out, Move Up, and Move Down options are used to control the
display of data in the PMT Counts and Analog (DPC-2 only) windows.  When one of
these menu options is selected, the mouse cursor changes from the standard pointer to an
icon indicative of the selected option.  The new mouse cursor is visible only when the
mouse is moved over the PMT Counts or Analog windows.

! When Zoom In is selected, the mouse cursor changes to a magnifying glass
containing a plus sign.  The left mouse button can then be used to zoom in on any area
of interest in PMT Counts or Analog.  The extent that the Zoom In selection will
zoom in on the data displayed in the active window depends on the setting of Zoom
In.  This is set using the View / Settings… command, as discussed below.

! When Zoom Out is selected, the mouse cursor changes to a magnifying glass
containing a minus sign.  The left mouse button can then be used to zoom out of any
area of interest in PMT Counts or Analog.

! When Move Up is selected, the mouse cursor changes to an upward pointing arrow.
The left mouse button can then be used to move the data displayed in the PMT Counts
or Analog windows in an upward direction.  The data can only be moved upward after
the Zoom In function has been performed and only if the display is not already at its
upper limit.

! When Move Down is selected, the mouse cursor changes to a downward pointing
arrow.  The left mouse button can then be used to move the data displayed in the PMT
Counts or Analog windows in a downward direction.  The data can only be moved
downward after the Zoom In function has been performed and only if the display is
not already at its lower limit.

Shortcuts to the Zoom In, Zoom Out, Move Up, and Move Down features are also
available as icons in the Toolbar.  For more information on viewing data, see Chapter 8:
Viewing Data.  For more information on using the icons in the Toolbar, see Chapter 6:
Using the Icons in the Toolbar.

View / Unzoom
Unzoom returns the scale of the Y axis of the active window to the original completely
unzoomed value.
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In the PMT Counts window, the maximal value of the value indicated on the Y axis after
Unzoom has been selected depends on the rate of data acquisition.  If the scale is set to
display the intensity data in counts, then the maximum value will be 65,535 counts (e.g.,
216-1).  If the scale is set to display the photon count intensity in Counts/Sec, then the
maximum value will be 65,535 divided by the sampling time in seconds.  In either case,
the maximal value displayed on the Y axis after selecting Unzoom is the intensity that
will cause saturation of the counter.

In the Analog window, selecting Unzoom will set the Y axis scale to display from 0 to +5
Volts.

View / Settings...
View / Settings… is used to manually set the Y axis scale of active window and to set the
magnitude of the zoom when Zoom In is selected.

Figure 8.  The Settings dialog box.

The maximum and minimum values of the Y axis are entered in the Axis Value section of
the Dialog box.  The value entered for Zoom Ratio sets the extent that the Zoom In feature
will zoom in the active data window.  This value can range from 0 to 100%.  A value of
50% will decrease the scale of the Y axis by 50% (a factor of 2).

Accepting and Canceling Changes
Clicking on OK closes the Settings Dialog Box and saves all changes.

Clicking on Cancel cancels all changes and causes the Settings to remain the way they
were prior to opening the Settings Dialog box.

Window Menu
The following menu items are available in the Window menu:

! New PMT Counts
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! New Analog
! Cascade
! Tile
! Arrange Icons
! 1... (etc.)

Window / New PMT Counts and / New Analog
Selecting New PMT Counts or New Analog opens an additional PMT Counts or Analog
window, respectively.  The newly added window initially inherits default attributes for
this type of window.  The additional window, however, can be customized to display data
in a fashion that is different from and independent of other windows of the same type.  For
instance, two separate PMT Counts windows can be used to monitor the photon count
intensity and the data can be scaled differently in each window.

Any number of additional data windows can be opened to customize the viewing of your
data.  The presentation of the data, however, may appear sluggish if too many data
windows are open.  The ability of Data Acquisition software to display data in multiple
windows depends on the speed of your computer and computer graphics.

Window / Cascade
Displays all child windows in a cascade.

Window / Tile
Displays all child windows in a tile display.

Window / Arrange Icons
Arranges at the bottom of the screen, above the status bar, the icons of all child windows
that have been minimized.

Window / 1... (etc.)
Changes the active window to the particular window selected from the Window menu list.
This action is analogous to clicking on the title bar of an inactive child window to make it
the active window.

Help Menu
The following options are available in the Help menu.

! Online Manual – PDF

! Online Manual – HTML

! C&L Instruments Website

! About Acquisition…
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Help / Online Manual – PDF
This option opens a help file as a PDF (Portable Document Format) document.  The PDF
file contains bookmarks to facilitate navigation through the document.  To open this file,
you must have Adobe  Acrobat  or the Adobe  Acrobat Reader  (version 3.0 or greater)
loaded on your computer.  Information about Adobe Acrobat can be obtained from the
Adobe website (www.adobe.com).  This version of the help file is essentially the same as
the HTML version.

Help / Online Manual – HTML
This option opens a help file as an HTML (Hypertext Markup Language) document in
your default web browser application.  This version of the help file is essentially the same
as the PDF version.

Help / C&L Instruments Website

Selecting this option opens your default web browser and loads the home page of the C&L
Instruments Internet website.

Help / About Acquisition…
Selecting About Acquisition displays on-line information about C&L Instruments, Inc.
and the version information about the Analysis software.

Toolbar
The Toolbar displays icons that can be used as quick shortcuts to may of the features
available in the Drop Down Menu Bar.  The Toolbar in Data Acquisition has “Bubble
Help”.  Moving the cursor over the icon will cause the display to indicate a brief
explanation of the function of the particular icon.  The use of these icons as shortcuts to
specific menu options is discussed in Chapter 6: Using the Icons in the Toolbar.

Status Bar
The status bar at the bottom of the main program window displays two types of status
messages:

! Ready - This is the default status message, which is generally displayed when the
program is ready and able to accept input from the user. The program is usually in this
state. For example, the software is in a “ready” state during data acquisition, since it
allows you to perform software functions using the drop-down menus or toolbar icons.

! Option description - When the cursor is moved over a drop-down menu option, the
status area displays a brief description of that option.
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Chapter 6: Using the Icons in the Toolbar

Overview
This chapter describes how the icons in the Toolbar can be used as short cuts to save time
when operating the Data Acquisition software.  Many of the program selections available
in the main Menu Bar are also available as icons.  The reader is referred to the previous
chapter, Chapter 5: Command Reference for an explanation of the functions represented
by these icons.

The Icons
The following is a list of the icons that are available in the Toolbar, together with the
function they represent.  These functions can also be found in either the main Menu Bar or
the Setup Options dialog box.

  File / Open   File / Save

  File / Print…   Help / About C&L…

  File / Setup Option…   File / Run

  Shutter / Open Shutter 1   Shutter / Open Shutter 2

  Record / Start   Record / Stop

  Record / Timed   View / Zoom In

  View / Zoom Out   View / Move Up

  View / Move Down   View / Unzoom

  View / Setting…
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Chapter 7: Acquiring Data

Overview
This chapter describes how to use the C&L Digital Photon Counting system to acquire
photon-counting and analog data.  A brief overview of the key features discussed in the
present chapter can be found in Chapter 3: Fundamentals of Data Acquisition.  Detailed
explanations of the various software functions available in the menu bar can be found in
Chapter 5: Command Reference.  The user is encouraged to first become familiar with
these functions prior to operation of the C&L DPC.

Data and Configuration Files
The C&L DPC uses two types of files: data files and configuration files.

Data Files
The Data Acquisition software creates data files and saves them with the extension of
“.flu”.  The C&L Instruments Digital Photon Counting system Data Acquisition software
creates these data files, which are used by the Data Analysis software.  The Data
Acquisition software does not read or use these files in any fashion for operation of the
C&L DPC system.  Once saved by Data Acquisition, the files must be opened by Data
Analysis to either view or analyze the data.

Configuration Files
A configuration file, which has the extension of “.cfg”, is used to store all operating
parameters Data Acquisition software of the C&L DPC system.  One or more
configuration files can be stored for recalling previously saved setting.  Configuration files
are used to save operation settings so that they can be quickly retrieved at a later date.
The Open and Save menu options under the File menu are used to open and save
configuration files.

Configuration files can be used for specific data acquisition tasks that may become
repetitive.  For instance, if a particular experiment requires the measurement of photon
counts at a particular sampling time and with specific analog channels, a new
configuration file can be saved for later recall after the DPC system is set up the first time.
It is recommended that the user should save the current configuration file using a new
name if the previous setup will be used at a later date.

Using the Setup Options
All of the major features of the C&L DPC system can be set for the measurement of
photon counts and analog data using the tabbed Setup Options dialog box.
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Using Run
The Run command is used to initiate the monitoring of PMT Counts and Analog data
(DPC-2 only).  Run also allows the data to be viewed in the data windows.  When the
Data Acquisition program is first started, data cannot be viewed (i.e., monitored) in the
data windows (PMT Counts, Analog) until the Run command is issued.  Likewise, data
acquisition cannot be started, using either the Start or Timed options, without first
initiating the Run command.  Until the user issues the Run command, the Start and
Timed options are disabled.

Issuing the Run command a second time reverses the action of the Run command.  It
stops all data monitoring activity.  This feature can be used prior to setting the DPC
system to new acquisition mode.  The Run command is also available as an icon in the
Toolbar.  This icon appears “pushed” when run has been selected and “flush” when it has
been depressed after Run is selected.

Avoiding Peak Pile Up
PMT’s used with the C&L Instruments Digital Photon Counting system will count
photons in a linear fashion up to a specified count rate.  When this count rate is reached,
exposure of the PMT to increasing amounts of light may cause the observed count rate to
decrease.  This is normal behavior, which is caused by Peak Pile Up.

When the count rate becomes excessive, the time between pulses becomes very short and
the detection circuitry cannot distinguish between the end of one pulse and the beginning
of the next.  The result is that pairs of pulses in close sequence get counted as one pulse
and the overall count rate begins to decline.  Peak Pile Up can be detected by attenuating
the light intensity impinging on the PMT.  If the count rate is observed to increase after
the light intensity is decreased, then peak pile up is probably occurring.

If Peak Pile Up occurs, the user can decrease the count rate by lowering the exposure of
PMT to the measured light by using a neutral density filter.

Using the Shutters in the Measurement of Fluorescence

Shutters
The C&L Digital Photon Counting system can control two independent shutters.  If the
DPC system is used for measurement of fluorescence intensity, these shutters can be
configured to function as excitation and emission shutters.  An excitation shutter in the
illumination optical path and an emission shutter in the detection path can be controlled
independently by the Data Acquisition software.  The three operation modes for the
shutters are selected using the Shutter Mode tab of the Setup dialog box.  See Chapter 5:
Command Reference for an explanation of these settings.

For fluorescence measurements, the shutters are used for two purposes:

1. The excitation shutter (Shutter 1) is used to block illumination of the sample.

2. The emission shutter (Shutter 2) is used to block detection of the excitation light by
the PMT and to prevent exposure of the PMT to room light.
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Blocking excess illumination light with the excitation shutter is commonly used to limit
photobleaching of the sample.  Photobleaching is generally observed as a steady decline in
the fluorescence of a sample that can be stopped by blocking the excitation light.  The
susceptibility of a particular fluorescent probe to photobleaching is dependent on the
particular probe and its environment.

When the Data Acquisition software is started, the shutters will initially be set to the
closed position.  If the user exits the Data Acquisition software with the shutters in the
open position, it is possible that the shutters will initially be in the open position the next
time the Data Acquisition software is started if the computer has not been shut off in the
interim.  If you use the shutter control features of the DPC system, it is always good
practice to close the shutters prior to quitting the Data Acquisition program.

Acquiring Analog Data
The C&L DPC system can record analog data along with the recording of photon counts
(DPC-2 only).  Eight analog inputs are provided that can be used to acquire data in the 0
to +5 Volt range.  The user should avoid applying voltages outside this range to these
inputs.  If the user requires collecting data over a wider range (e.g., 0 to +10 Volts), a
voltage divider should be inserted between the signal source and the analog input of the
Digital Photon Counting system.  Contact C& L instruments if assistance is required.  The
acquired data is viewed in the Analog window.  The Dye Fluorometer acquires analog
data in synchrony with the PMT Counting data.   Details of the timing of analog and PMT
Counts data acquisition are discussed in Chapter 9: Timing Considerations.

In order to display analog data in the Analog window and to record analog data from a
particular channel, the analog channel must be first enabled.  Analog channels are enabled
and disabled through software using the Analog tab in the Setup dialog box.  See Chapter
5: Command Reference for details of this feature.

Enabling an analog channel connects the input signal to the Analog to Digital Converter
(ADC) used by the DPC system.  When an analog channel is disabled, the input signal is
disconnected from the ADC and the input to the ADC for that channel is grounded (the
signal is not grounded).  This prevents a “floating signal” from being presented to the
ADC.

Recording and Saving Data
Recording or acquiring data is initiated with the Record / Start or Record / Timed
command.  The Record command will begin data acquisition in a manner that requires the
user to select the Recond / Stop command to stop the recording of data.  Selecting
Record / Timed will begin data acquisition that will last for the duration of time specified
in the Record tab of the Setup Options dialog box or until the Record/ Stop command is
selected, which ever occurs first.

In the normal mode of operation, starting the recording of data using either the Record /
Start or Record / Timed commands will start data recording immediately and the
recording of data will be continuous until it is stopped.  This is the preferred mode for
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continuous and uninterrupted data recording.  The Single Sample Mode is used for non-
continuous recording of data.

Using the Single Sample Mode
The Single Sample Mode is used when the user wants the collection of data to be
interrupted one or more times, but yet have the data recorded in one file.  It is also useful
for data averaging.  With this mode, numerous measurements of the photon counts and
analog signal can be made and averaged together as one data point in an automated
fashion.

Operation of the DPC system in the Single Sample Mode is selected by enabling this
feature using the check box in the Record tab of the Setup Options dialog box.  (See
Chapter 5: Command Reference).  When enabled, selecting the Record / Start command
will open a dialog box, as shown in the following figure.

Figure 9.  The Single Sample Record dialog box.

The Single Sample Mode dialog box contains 5 main selection buttons, 3 places for data
entry and a message box.  The Single Sample Mode is setup by entering values in the data
entry box labeled “Average” and the entry boxes labeled Auto Record.

In the Single Sample Mode, data is recorded to a data buffer.  The user has the option of
saving the data to disk at any time, or deleting the last or all of the data points in the
buffer.  The 6 selection buttons controls recording of data into this buffer, deleting data
from the buffer and saving the data to disk.  This is discussed more fully below.
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Data Averaging
The entry on the Data Averaging data box indicates how many data points will be
averaged together for signal averaging purposes.  An entry of 1 indicates that no signal
averaging will occur.  Valid entries are between 1 and 500.  A value greater than 1 will
initiate on-line data averaging.  When this feature is enabled, the signal-averaged data is
displayed on the data widows.

Data averaging affects the PMT Counts and Analog data.

Auto Record
Auto record is used to automate the collection of data in the Single Sample Mode.  When
the Auto Record feature is not used, either single data points or averaged data points will
be collected whenever the Record New Data button is selected.  With Auto Record is
used, a data set is recorded once every interval that is indicted in the Auto Record dialog
box.  Data will be recorded in this manner for the total number of points that has been
specified in this dialog box.

For instance, if Auto record is set to record 20 sample(s), every 2 minute(s), then one data
set will be recorded when the Record New Data button is selected and additional data
sets will be recorded every 2 minutes until of total of 20 sets are recorded.

The Auto Record feature is enabled with the check box.

If the time needed to acquire data is longer than the duration of time between data
acquisition periods entered in the Auto Record dialog box, the user will be prompted to
lengthen the auto record time.  This may occur if:

1. Too many data points are averaged to complete the sequence in the allotted time.

2. The Sampling time is too long.

Record New Data
Record New Data begins a data acquisition sequence.  When this button is selected, a
data set is recorded and stored in a data buffer.  These data can be either a single data
point or a data point acquired by signal averaging.

Discard Last Data
Discard Last Data will delete the last data point that was collected the last time that
Record New Data was selected.  The number of data sets collected is indicated in the
message box in the top of the Single Sample Record dialog box.  Discard Last Data can
be selected repeatedly to remove more than one data set.

Discard All Data
Discard All Data will clear the data buffer and delete all previously collected data that
was collected using the Single Sample Mode.  All data will be deleted from the data
buffer that was acquired since the last time that Discard All Data was selected
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Close the Dialog Box
Close the Dialog Box will close the Single Sample Mode dialog box.  It is important to
note that selecting Close the Dialog Box will not clear the data buffer of previously
acquired data.  To clear the data buffer, the user must select Discard All Data.  Once the
Single Sample Mode dialog box is closed, it can be reopened using the Record / Start
command. Closing and reopening this dialog box does not affect the data in the data
buffer.

Save to Disk
Save to Disk permanently saves the data that has been stored in the data buffer to disk
using the file name and location specified in the Record tab of the Setup Options dialog
box.  The Auto Increment File feature is also supported.  When Auto Increment File is
enabled, selecting Save to Disk will save the file to the next numbered file name.

It is important to note that selecting Save File to Disk does not clear the data buffer.  If
Record New Data is selected after selecting Save File to Disk, the next file saved to disk
will contain the original data plus the newly added data. Usually, Discard All Data is
selected after selecting Save to Disk, however, this not need be the case.  In some
instances, it may be useful to save a second file with added data.

Stop Recording Data
Stop Recording Data aborts a data acquisition sequence that had been initiated enabling
the Auto Record feature.  When this button is selected, a data acquisition sequence that
had been programmed to occur in an automated fashion using Auto Record can be
aborted.

Tips for Using Single Sample Mode
The Auto Record feature is particularly useful for collecting data under four types of
conditions.

1. In the measurement of fluorescence, some samples are especially vulnerable to
photobleaching, Auto Record can be used with the Auto Always shutter mode to
block illumination of the sample between periods of data acquisition.

2. If the user wants to record data over a long period of time, but continual data
acquisition is not needed.  Recording data continuously over a long period of time
generates large data files that are more cumbersome to analyze.  This is generally
not required if the signal is changing slowly.

3. If the signal is noisy, the signal-averaging feature of Auto Record can be used to
eliminate random noise.

4. If several different samples are measured and the user wishes to record the data in
one file.  This is especially useful with the C&L Instruments Model CV1 Cuvette
Accessory.  A data set can be acquired for one sample and the sample changed
prior to collection of the next data set.
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Resizing Windows during the Recording of Data
The Windows  operating system functions in a multitasking and object-oriented
environment.  Because of this, some program functions are curtailed when others are
permitted to take precedence.  As a result, some features in the Windows  operating
system can cause loss of data during periods of rapid data acquisition.  This is not a
deficiency in the design of the Data Acquisition software, but rather a consequence that
exists in all software written to operate in a multitasking environment.

During data acquisition and at all other times, the operating system must monitor the
users’ input via the keyboard and the mouse.  Certain input operations can significantly
decrease the processing time available to other operations.  The primary Windows

operation that can affect data collection by the Data Acquisition software is the
positioning and resizing of program windows.  When the user clicks on the title bar of an
active window to reposition it on the screen, execution of the underlying program is
curtailed for the duration of time in which the mouse button is depressed.  For this reason,
repositioning and resizing windows during data acquisition is discouraged since it may
lead to loss of data.  Whether or not data is lost depends on several factors, but the
primary factor is the rate of data acquisition.  It is recommended that the user size and
position the data windows prior to starting data windows acquisition.
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Chapter 8: Viewing Data

Overview
The C&L Instruments Digital Photon Counting system allows the user to monitor PMT
Counts and Analog data (DPC-2) simultaneously in separate data windows.  Moreover,
data can be monitored in real time between and during periods of active data collection.
This chapter is intended to provide the user with a practical guide for viewing data with
the DPC system Data Acquisition software.  A detailed discussion of all the features of the
software are provided in Chapter 5: Command Reference.

Use of the Right Mouse Button
The Data Acquisition software has been written to take advantage of the right mouse
button.  Clicking the right mouse button in various areas of the data windows will open an
option selection box, which is appropriate for that area of the data window, to allow the
user to change display options.  This can be used as a short cut to more quickly change
display options, rather than using menu items in the main Menu Bar.  The options
available with the right mouse button are discussed in this chapter in relation to the
particular data window.

Data Windows
Data obtained by the DPC system are viewed in two types of data windows.  These are the
PMT Counts and Analog windows.  In addition, a Timer window is displayed to show the
progress of time as the data is updated in the data windows.  Details of these windows are
discussed below.

Timer Window
The Timer window shows either a blank or static graph when Data Acquisition software is
not in the Run mode.  After selecting File / Run, a horizontal bar is displayed on this
graph.  The movement of horizontal bar indicates the progress of time and the position of
the new data being updated in the data windows.  The Timer windows cannot be resized
or disabled.

During the recording of data, a digital clock is displayed under the X axis of this graph to
indicate the amount of time that has elapsed since the recording of data was started.

PMT Counts Window
The PMT Counts window is used to display the intensity of the light measured by the
PMT attached to the DPC system.  Many of the display features can be obtained using the
right mouse button.  Clicking the right mouse button in the center of the PMT Counts
window will open the Display selections.

Several PMT Counts windows can be opened using the View / New PMT Counts menu
item and each can be set to display the data with different scaling.
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Data Overflow
The Digital Photon Counting system can accumulate 65,536 counts (i.e., 216) within one
sampling period.  If more counts are detected within the sampling period, a data overflow
condition will exist.  If this occurs, a warning message (DATA OVERFLOW) is displayed
along the X Axis of the PMT Counts window.

To correct a data overflow condition, the user has several options.

•  Decrease the intensity of the light impinging on the PMT.

•  If measuring fluorescence, decrease the concentration of the sample or the
concentration of the fluorescent species in the sample.

•  Decrease the sampling time so that fewer counts will be detected within the
sampling time period.  If decreasing the sampling time will generate too much data
for a given experiment, the signal averaging feature can be used to limit the
amount of data recorded.

It is important to note that this data overflow condition is different from the problem
caused by exceeding the count rate of the PMT.  In a data overflow condition, the
limitation is not the PMT, but rather the amount of counts that can be detected within the
sampling period.  This limitation is not necessarily caused by excessive light impinging on
the PMT.  Selecting a long sampling time that is not appropriate for the intensity of the
measured light can also case a data overflow condition.  See also Avoiding Peak Pile Up
in Chapter 7: Acquiring Data.

Analog Window
The analog window is used to display the acquired analog voltages (DPC-2 only).  The
default scaling of the Y Axis is the 0 to +5 Volt limit of the Analog to Digital Converter.
As with the other data windows, many of the display options are available using the right
mouse button.

The displayed analog channels can be selected by clicking in the top center position of the
graph with the right mouse button or by selecting Display in the main Menu Bar. The
analog channels that are available for display are those channels that have been enabled in
the Analog tab of the Setup Options dialog box.  See Chapter 5: Command Reference
and Acquiring Analog Data in Chapter 7: Acquiring Data.

Clicking in the center of the Analog widow graph with the right mouse button will open
options for scaling the graph.  These options are also available by selecting View in the
main Menu Bar.

Several Analog windows can be opened using the View / New Analog menu item and
each can be set to display one or more analog channels.
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Chapter 9: Timing Considerations

Overview
The Data Acquisition software acquires analog data (DPC-2 only) in synchrony with the
PMT Counts data.  The user should be familiar with these timing considerations for proper
interpretation of the data collected by the DPC system.

Synchronous Data Acquisition Timing
The C&L DPC system can acquire Analog data in addition to PMT Counts data (DPC-2
only).  The acquisition of analog and PMT Counts data occurs in a synchronous fashion.
As a result, the rate of analog data acquisition is dependent on the sampling time, as
specified in Sampling Time tab of Setup Options dialog box.

Up to eight analog data channels can be acquired.  Specific channels are enabled using the
Analog tab in the Setup Options dialog box.  Analog data is acquired for the analog
channels that are enabled, whether or not the display of these data is enabled in an Analog
window.

In the DPC system, photons are counted over the period of time designated as the
sampling time.  At the end of this sampling time, data is acquired simultaneously from all
the analog channels.  The analog data from all enabled channels is captured
simultaneously.  The data captured in this way can be considered a “snap shot” of the
voltages that are present on the analog channel inputs at that moment in time.  The time at
which this “snap shot” is taken is synchronous with the end point of each sampling time
window.

This is illustrated in the following Timeline diagram.  The first row of numbers indicates
the data number of the PMT Counts data.  The width of the box represents the duration of
the sampling time.  The second row of arrows indicates the timing of the analog data
acquisition.  Note that a given data point of the Analog data is acquired at the end of the
corresponding sampling widow in which PMT Counts were accumulated.

Timeline

PMT point number

1 2 3 4 5 6 7 8 9 10 11

↑ ↑ ↑ ↑ ↑ ↑ ↑ ↑ ↑ ↑
1 2 3 4 5 6 7 8 9 10

Analog point number
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Chapter 10: Troubleshooting
If you have trouble operating the C&L DPC system, please follow these steps in the
indicated order.

1. Consult the manuals for the hardware components of the C&L DPC system.

2. Consult this chapter for answers to common problems.

3. Contact C&L Instrument, Inc.  Contact information is given in the front of this
manual.

Symptom Possible Problem Possible Solution

Main program window opens
without any child windows and
most menu items are disabled.

A configuration file has not been
loaded.

Use the File, Open command to
either open or create a new
configuration file.

PMT Counts data is not visible
in the PMT Counts window.

Run command is not enabled. Enable the Run command using
Run menu item under File menu
or the Run icon.

Viewing of PMT Counts data is
not enabled

Make sure the PMT Counts
window is active, then enable
viewing of data using the View
menu.

Data is off scale Use the Unzoom feature in a
PMT Counts window.

Colors of data point(s) are the
same as the graph background
color.

Change the color of the data
points using the Color… menu
item under Options.

Analog data is not visible in the
Analog window.

Run command is not enabled. Enable the Run command using
Run menu item under File menu
or the Run icon.

Acquisition of Analog data is
not enabled.

Enable one or more analog data
channels using the Analog tab in
the Setup Options dialog box.

Viewing of Analog data is not
enabled.

Make sure the Analog window
is active, then enable viewing of
data using the View menu .

You have the DPC-1, not DPC-2 Analog data acquisition is a
feature of the DPC-2, not DPC-
1.  To acquire analog data, you
must upgrade to the DPC-2.

Colors of data point(s) are the
same as the graph background
color.

Change the color of the data
points using the Color… menu
item under Options.

Selecting Record / Timed or
pressing the Timed Recording
icon does not appear to initiate
data recording.

Zero time has been entered as
Recording Time duration in the
Record tab of the Setup Options
dialog box.

Enter a number in the Recording
Time section in the Record tab
of the Setup Options dialog box.

The Run command is not
enabled.

Enable the Run command using
Run menu item under File menu
or the Run icon.
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Chapter 11: Agreement, License and Warranty

Agreement and License
C&L Instruments, Inc. (“C&L”) provides this instrument, including its software program,
and licenses the use of the software program, according to the following terms and
conditions.

Definitions:
Instrument: The instrument provided and any components thereof, not including

any software programs enclosed.

Software: The computer programs enclosed.

Product: All of the materials provided with this License Agreement, including
the fluorometer or any components thereof and/or software.

You may:

(i) use the software program on a single machine;

(ii) copy the software program into any machine-readable or printed form for backup
purposes in support of your use of the software program on the single machine. (Certain
programs, however, may include mechanisms to limit or inhibit copying.  They are
marked "copy protected").

You may not:

(i) modify the software program and/or merge it into another software program for your
use on the single machine without the written consent of C&L;

(ii) transfer the software program and license to another party without the written consent
of C&L.

Copyright Notice
YOU MAY NOT USE, COPY, MODIFY, OR TRANSFER THE SOFTWARE
PROGRAM, OR ANY COPY, MODIFICATION OR MERGED PORTION, IN WHOLE
OR IN PART, EXCEPT AS EXPRESSLY PROVIDED FOR IN THIS LICENSE.

IF YOU TRANSFER POSSESSION OF ANY COPY, MODIFICATION, OR MERGED
PORTION OF THE SOFTWARE PROGRAM TO ANOTHER PARTY, YOUR
LICENSE IS AUTOMATICALLY TERMINATED.

Term
The License Agreement is effective until terminated.  You may terminate it at any time by
returning or destroying the Software together with all copies, modifications and merged
portion in any form.  It will also terminate upon conditions set forth elsewhere in the
Agreement or if you infringe any C&L copyright or any other intellectual property right or
fail to comply with any term or condition of this Agreement; you agree upon such
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termination to destroy the software program together with all copies, modifications and
merged portions in any form.

Limited Warranty
C&L warrants that the Instrument and/or components shall be free from defects, not
including consumables, such as lamps and interference filters, for a period of one (1) year,
following date of purchase when used under normal conditions.  Optics, including lenses
and heat filters are subject to these limited warranties for thirty (30) days.  The neutral
density filter, if provided, is not covered by this warranty.  All repairs must be made by
C&L and Customer must return the Instrument and/or component to C&L, at
customer’s cost, for repair.  Return of the instrument for repair must be
preapproved by C&L.

THE FOREGOING WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES,
EXPRESS OR IMPLIED.  YOU ASSUME FULL RESPONSIBILITY FOR THE
SELECTION OF THE PRODUCT TO ACHIEVE YOUR INTENDED RESULTS, AND
FOR THE INSTALLATION, USE AND RESULTS OBTAINED FROM THE
PRODUCT.

OTHER THAN AS STATED ABOVE, THE PRODUCT IS PROVIDED "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTY OF
MERCHANTABILITY AND FITNESS FOR PARTICULAR PURPOSE.  C&L DOES
NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE OR
THE INSTRUMENT WILL MEET YOUR REQUIREMENTS OR THAT THE
OPERATION OF THE INSTRUMENT AND/OR SOFTWARE WILL BE
UNINTERRUPTED OR ERROR FREE.  THE ENTIRE RISK AS TO THE QUALITY
AND PERFORMANCE OF THE SOFTWARE IS WITH YOU.  SHOULD THE
SOFTWARE PROVE DEFECTIVE, YOU (AND NOT C&L OR ANY AUTHORIZED
REPRESENTATIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY
SERVICING, REPAIR OR CORRECTION.

THIS PRODUCT IS NOT INTENDED OR SUITABLE FOR USE IN HUMAN
RESEARCH OR FOR DIAGNOSTIC PURPOSES.  C&L DOES NOT
RECOMMEND THE USE OF THIS PRODUCT FOR APPLICATIONS IN
WHICH ERRORS OR OMISSIONS COULD THREATEN LIFE, INJURY OR
SIGNIFICANT LOSS.

Limitation of Remedies
IN NO EVENT WILL C&L, ITS DISTRIBUTORS AND DEALERS BE LIABLE TO
YOU FOR ANY DAMAGES OF ANY KIND OR NATURE, INCLUDING BUT NOT
LIMITED TO, ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL,
CONSEQUENTIAL OR SPECIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY TO USE SUCH PRODUCT, EVEN IF C&L OR ITS AUTHORIZED
REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.
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United States Federal Government Restricted Rights
If this Software is acquired by or on behalf of the U.S. Federal government, this provision
applies.  Use, duplication or disclosure of this Software is subject to restrictions set forth
in FAR 52 227-19 and DFAR 227 7200-227 7202-1, as applicable.  The Software is
“commercial computer software” and is licensed with only “Restricted Rights.”

General
This License Agreement is your proof of license to exercise the rights granted herein and
must be retained by you.  You may not reverse engineer, decompile, or disassemble the
software.  You may not sublicense, assign or transfer the license or the software except as
expressly provided in this Agreement.  Any attempt otherwise to sublicense, assign or
transfer any of the rights, duties or obligations hereunder is void.  Warranty is void if
instrument, components and/or software is subject to abuse, misuse or unauthorized
modification.

Whenever possible, each provision of this License Agreement shall be interpreted in such
a manner as to be valid and effective under applicable law.  If any provision is found to be
unlawful, void or for any reason unenforceable, then that provision shall be deemed
severable from this License Agreement and shall not affect the validity and the
enforceability of the remaining portions of this License Agreement.  This Agreement will
be governed by the laws of the Commonwealth of Pennsylvania.

Should you have any questions concerning this agreement, you may contact C&L at 314
Scout Lane, Hummelstown, PA, USA, 717-566-3642.

Excel®, Word®, Notepad®, and Windows®, are registered trademarks of Microsoft
Corporation.

Pentium® is a registered trademark of Intel Corporation.

Adobe , Acrobat  and Acrobat Reader  are registered trademarks Adobe Systems
Incorporated.
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